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Welcome to

With CallPilot Desktop Messaging from Nortel Networks you can access your CallPilot
mailbox from your personal computer. You can manage all your voice messages in one
graphical interface. You can still access your mailbox from your telephone at any time.

With CallPilot Desktop Messaging you can:

¢ listen to voice messages

record and send voice messages

forward and reply to voice messages

add message options such as urgent and private
change your CallPilot password

* & & o

Refer to the online Help available with CallPilot Desktop Messaging for detailed information
not covered in this guide.
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Logging on

Use your CallPilot password to log on to Desktop Messaging.

To log on from Microsoft Outlook, Lotus Notes, or
Novell GroupW|se Q Server: Itormactrial
1 Open Microsoft Outlook, Lotus Notes, or Novell SMTPAVPIM pefi. [1416597
G Wise. - '
roupttise. - . Maibor: [iz34
2  Type your CallPilot password in the Password box. . . |
asgword: e
3  Click the OK button. _
1L L e e

oK I Cancel |

To log on from an Internet mail application

1 Open your Internet mail application. The Password
window is similar to the one shown. Password for IMAP user 14155977386 on
tormactial.ca.horkel com
2 In the Password box, type your CallPilot password.
3 Click the OK button. =

Remote logon

You can log on to your CallPilot mailbox from any computer that has Desktop Messaging installed and
configured in the same way as your office computer. For example, you can use a computer that is set
up for guest access, or your home computer with a dial-up connection to the server.
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Changing your CallPilot password

You can change your CallPilot password from Desktop Messaging or from your telephone.

To access CallPilot Password Change from Microsoft Outlook
1 In your Inbox, on the Tools menu, click Services.
The Services dialog box appears with the Services tab open.
2 Select CallPilot Desktop Messaging, and click the Properties button.
3 On the General tab click the Change Password button.

To access CallPilot Password Change from Lotus Notes
1 Inyour Inbox, on the Actions menu, click CallPilot Configuration, and then click the General tab.
2 Click the Change Password button.

To access CallPilot Password Change from Novell GroupWise

1 Inyourinbox, on the Tools menu, click CallPilot Desktop Messaging, select CallPilot Desktop
Messaging Options, and then click the General tab.

2 Click the Change Password button.

To access CallPilot Password Change from Internet mail applications

You must have the CallPilot Player installed on your computer.

1 Click the Windows Start button, select Programs, select Nortel Networks CallPilot Desktop
Messaging, and then click CallPilot Player.

2 Onthe Tools menu, click Options, and then select the IMAP Server Configuration tab.

3  Click the Change Password button.

To change your password

1 Inthe Old password box, type your current

password.
2 Inthe New password box, type your new password. Q
3 Inthe Validate password box, type your new

password again.

4 Click the OK button. oK. | Cancel

0Id paszward: | xxxxxxx

Mew pazeword: I

Walidate password: I
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CallPilot supports two types of voice files: wav and vbk.

If you want to send messages to external recipients who are not on your CallPilot system, you can
configure CallPilot to use the format that is appropriate for the recipient.

To configure CallPilot to automatically use the format that is appropriate for your recipients

1

2
3

4
5

On the Tools menu click Services.
The services dialog box opens.

In the list select CallPilot Desktop Messaging.

Click the Properties button.
The CallPilot dialog box opens with the General tab open.

Select the Use CallPilot form check box.
Click the OK button.

Now when you send messages to CallPilot and non-CallPilot recipients, CallPilot automatically sends
the message in the format that is appropriate for the recipient.
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GallPilot Desktop Messaging
for Microsoft Outlook

You can use CallPilot Desktop Messaging with Outlook 98, Outlook 2000 and Outlook XP. When you
open Microsoft Outlook, your CallPilot messages appear in the Inbox under the CallPilot Message
Store. From the Inbox, you can open, move, copy, delete, forward, and reply to messages, and
compose new messages.

The CallPilot indicator in the Windows system tray turns red when you have a new message.

The CallPilot To open a Read receipt shows New messages To create a new
Message message, double- that your message was appear in bold message, click
Store click the message opened by the recipient the New CallPilot

contains line Message icon
your
received @ Inbox - Microsoft Dutlook M |[=] 3}
sent. and | Ble Edt View Favortes Is Actions Express Help
deleied Gtew - & |05 % | @D FoRepl to Al 4 Fornand | BB sen\Receive | BirFind g Orgenice | 2 \ @,
CallPilot
messages Foldy List x| 1/ 0 1@/ From [Nobject [Received © \ [=]
=-L2 CallPilot Message Store @ Kirchmaier, Cheryl [WIC:9TB... Read: Tomorrow's meeting  Mon 2/4/2002 2:24 PM
13 Deleted ltems =) sewel, Scott [BVW:9B21:EXCH]  RE: CP Mini Message Metworkin...  Mon 2/4/2002 1:34 PM
% Inbos =) Postey, Patricia [WIC:DS&0:EXCH]  printing duples: Mon 2/4/2002 1:13 PM
Outhox Levchuk, Liza [WIC:D580:EXC... Re: Feedback request Mon 2/4/2002 1:12 PM
When yOU {1 Sen ltems ! = Levchuk, Liza [WIC:D580:EXC... Yacation request Mon 2/4/2002 1:09 PM
delete a \ =2 Dutlook Today - [Mailbos - L ] Dhalial, Hardsep [WIC:9T84E. .. Documentation wed 1/30/2002 10:52 AM
message from \\ (3 Calendar \C Fraser, Brent [WIC:DSB:ERCH]  Vacation Database updated wed 1/23(2002 10:43 AW
Inb it N g gz::f:fuams £\ O Waeyen, John [WIC:DSS0:EXCH]  RE: new windows Fri 11/16/2001 9:33 AM
your InDOX, | =) Lotus Nokes Fri 6/29/2001 #:41 P
moves to the g |D,::':, @ L3 Re: support RESPONSE
{9 Joumnal
?(Ieclieteqr ltems P
olaer. 1o <25 Outhox
5 Sent ltems
delete B oks
messages BT my folders
permanently ez @ Public: Falders
4] | 1| -]
go TP)llOltJr 10 Items, 3 Unread \ \
allFllo
. \
mailbox, empty Exclamation mark shows Paperclip icon shows \Date and
your Deleted that this message is that this message has time

Items folder. urgent an attached file received

To work offline

To work offline, you need a computer that has Desktop Messaging installed and configured in the
same way as your office computer.

1 Log on to Microsoft Outlook.

2 Onthe Tools menu, click CallPilot Desktop Messaging, then click Download all CallPilot
Messages.

3  After the messages download, log off.

4 When you log on again, you can choose to work offline. While you work offline, you can review
your messages and record new messages from your computer. CallPilot stores your new
messages in your Outbox and sends them the next time you log on to the CallPilot server.
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Playing a message

To play a voice message
To open a voice message, double-click the message line. The CallPilot Player appears.

You can choose to play your voice messages from your telephone or your computer by clicking the
Telephone or Computer icon on the CallPilot Player. You can change this selection at any time. If you
select Telephone, the phone rings when you open a message, and the message plays when you

answer. If you select Computer, your messages play through your computer’s speakers or your
headphones.

Reply Reply to all Forward

B CailPilot Player - (7400] 0:18 Yoice Message

Open next
File  Edit “Sgmmands\ Tools Help /message
el Rpmewloe| alet—
Delete
message From: ok Smith
Tar |MAHIDN STIRRETT Open previous
[
e o | message
Position in : ——
message Subject: |[?4UEI] 0:08 Yoice Message
[ = g T Sensitivit}':IF’uinc 'I 24700127 P
Durationof | Yooz
message EI |_ ---------- 008 IIE?RTEI-
E ETWORKS | Status
Play/replay
\\._/Lll |«Lﬂ_ﬂﬂ| J |F'Ia_l,l|ng
, i Click to play
StOP/ ; — iy ———messages from
/ your computer
Adjust volume~"

Click to play
messages from
Go to start Sklp Go to end your telephone
of message Sklp back forward of message Adjust speed

To change your audio device

1 On the CallPilot Player by click the Telephone or Computer icon.
Or

1 Inyour Inbox, on the Tools menu, click Services.
2 Inthe list, select CallPilot Desktop Messaging and click the Properties button.

3  Click the Audio tab, and from the Audio device option select Telephone or Computer and click
the OK button.

To change the telephone number that CallPilot dials to play your voice messages
1 On the Audio tab select Telephone as your audio device, and then change the telephone number.
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You can record a voice message from the CallPilot player. The message you record can be a new
message, a reply to a received message, or an introduction to a forwarded message. Before you send
the message, you can add voice message attachments and options.

To record and send a voice message

You create a voice message by opening a new CallPilot message and recording a message from your
computer or your telephone. You can send the message or save it to send later.

1  On the Microsoft Outlook toolbar, click the New CallPilot Message icon.

2 On the CallPilot Player, click the Record button to start recording. Your message can be a
maximum of 10 minutes long.

3 If you are recording from the computer, record your message into the microphone. Click Stop to
end the recording.

If you are recording from the telephone, answer when it rings. At the tone, record your message.
Click Stop to end the recording, and then hang up.

4 Click To to open the CallPilot or Personal Address Book, or type the formatted address in the
To field. For addressing information, see “Addressing a message” on page 10.

5 Add attachments and options if required. See “Adding attachments” on page 9 and “Setting
Message options” on page 8.

6  On the toolbar, click the Send Message icon.

[E CaliPilot Player [_ (O] .
Fle Edt Commands Tools Help Click the Telephone
= S E | icon to open the
Send message =l=[=]] CallPilot Player, and
Save message Ta.. | [Doe. Jane then record your
Click to go to the ;;Il message
CallPilot or Personal = -
Address Book e .
_—Deliveny: INormaI j Sensitivity IF'uinc j ||: E:iia\?errecr:‘c?;i ¢ C_IICK the Attach
Message options: g 2 \Flle icon to attach
 Urgent or Normal a voice file
Delivery - Vioice .J . NQE!IE}O“S
« Public or Private e Click to record all
* Read receipt it | .| I«l "l »l »ll _‘.J ‘ | -messages from
. G »\— » @ g/ your computer
\ Click to record all
/| ~messages from
your telephone
Stop Adjust volume Record Adjust speed

To save a newly created voice message as a file
You can record a voice message and save it to use later.
1 In anew CallPilot message, record a message, and on the File menu, click Save as.

2 In the File name box, type a name for the file, select a folder to keep the file in, and then click the
Save button. Save a voice file as a vbk file if all your recipients are CallPilot users. If some
recipients are not CallPilot users, save a voice file as a wav file.
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Forwarding and replying to a message

You can forward a voice message and record an introduction to send with it. You can also record a
reply to the sender of a message, or to the sender and all the recipients of a message.

To forward or reply to a message

3 In an open message, click the Forward,
Reply, or Reply to all icon.

4  Follow the steps for recording a message in
“Recording a message” on page 8.

5 Address the message the same way that you
address a new message. See “Addressing a
message” on page 10. If you are replying to a
message, your reply is addressed
automatically.

You can change the subject line before you send

the message. The subject can be a maximum of 80

characters.

Note: Do not use the right-click menu to forward a
Desktop Messaging message. To forward a message,
either:
. open the message and forward it from the CallPilot
window
or

. select the message in the Outlook Inbox and forward

it from the Outlook toolbar.

I CallPilot Player M= E
File Edit Commands Tocls Help
E=TEIET
Ta.. | Dos.Jane
Cc..
Bco.
Subject: [Fw: [7400) 0:08 Vaice Message
Delves [Mormal [v] Sensiviy[Fubli: =] |- Dereee
—
 —— NRRTEL
{ ! NETWORKS
L [ A N
E—— 4 » ——

Before you send a message, you can attach a voice file to it. You can send either vbk or wav files to
CallPilot recipients. Voice files that you send to recipients who do not use CallPilot must be wav files.
For more information see “Sending a message to an external recipient” on page 5.

To attach a file to a message

1 In anew CallPilot message, click the Attach
File icon.

2 Browse for the name of the voice file that you
want to attach, or type the name of the file in
the File name box. The files you attach must
be in wav or vbk format.

3 Click the Open button to attach the file and
return to the new CallPilot message.

5 CallPilot Player

Fie Edit Commandf™Teer Rep

I8 [=] B3

=== i}iklﬂ

Tou | [Doe, Jane
Ce Open [2]x]
Bee -
e ll 3 ORGI075td - i
Subject: " [7400 _I _I I__I
ot
Deliven: [Homal 5 Foest i

= Speschvbk

Test Message

Voice Fie pame: [
Message

Open I
Files of type: [ Files [*wav.” vk G 14 = Cancel
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The CallPilot Address Book contains the names and addresses of everyone on your local CallPilot
server. You cannot edit this list. To use the CallPilot Address Book, download it to your computer.
To download the CallPilot Address Book

1 Inyour Inbox, on the Tools menu, select Services.

2 On the Services tab, select CallPilot Desktop Messaging.

3 Click the Properties button, and then click the Address Book tab.

4

Click the Download now button. To refresh the list on a regular basis, select the Remind me
check box and enter the number of days between reminders.

5 Click the OK button to return to your Inbox.

To add CallPilot addresses to your Personal Address Book

You can add CallPilot addresses to the list of e-mail addresses in your Personal Address Book. You
can distinguish between CallPilot and e-mail addresses by adding “CallPilot” after the recipient’'s name.

To add an address to your Personal Address New CallPilot Addiess Properties [x]
Book Business | Phone Numbers | Mote] CALLPILOT - General |
1 Double-click a name in the CallPilot Address Display name: [Fofn St

Book_ Local CallPilot server: |tormactria|.ca.nortel‘com
2 In Properties, click Add to Personal Address | [iFieages e ritvork maicox =

BOOk Address information

) (Netwurkmailbux: I ‘
. Enter the network mailb ber. & network mailb ber is the
To create an address and add it to your bt v ol se 0 adiess 3 messags to th reciplent usng
Personal Address Book Foment o, i s Eoem ] ot ol Calch et T
e remote server 1s not defined, create an Upen ar Gpen
th { i t defined, e o] AMIS or Oy WRIM

1 On the Tools menu, select Address Book. arkry.

2 On the File menu, click New Entry. Select
CallPilot Address, select Put this entry in the
Personal Address Book, and then click OK.

3 Click the CallPilot - General tab and select the Send Cptions, .
appropriate address type from the CallPilot
address type list box. Enter the required = II fre i i
address details. Refer to the online Help for the
correct addressing formats.

4  Click the OK button.

To address a message from your CallPilot or Personal Address Book

In a new CallPilot message, click the To button.

From the Show names list select CallPilot Address Book or Personal Address Book.
Select the name of the recipient.

Click To ->. You can select one or more addresses and click To -> after each one.

Click the OK button to return to the new CallPilot message.

A b ON -

To address a message manually

You can type an address directly into the To field of a new message. Enclose the address in square
brackets. Refer to the online Help for the correct addressing formats.
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In a new CallPilot message, you can set priority, sensitivity, and acknowledgment options.

To set Delivery priority for a message

Select Urgent, or leave the setting as Normal. The (TR [l E3
. . . File Edt Commands Took Help

Economy option is the same as the Normal setting. R
To set Sensitivity for a message LTo.. | Poe.Jane

. . . Cc.
Select Private, or leave the setting as Public. oo
- T
The recipient can forward messages that you send Detver [Trgem ] Senstiviy e =] 1%, Fesdrecet

as Private. Also, recipients in non-CallPilot systems

!
may not be informed of Private settings. In your —— NORTEL
. . Message
glr?\?::ege, tell the recipient that the message is > (] w<»]o] o]

¢ —— <4 » —— » B

To request a Read receipt

Select Read receipt to request acknowledgment =
that the recipient opened the message. Delivery
receipt is not supported.

When you delete a message in Microsoft Outlook, the message moves to the Deleted Items folder.

Outlook permanently deletes these messages from your CallPilot mailbox when you exit Outlook. The
messages are deleted immediately when you exit.
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When you open Lotus Notes and log on to CallPilot Desktop Messaging, you are in the Workspace at
Office window.

To open your CallPilot Inbox, click the Mail icon, click Folders and Views, and then click CallPilot
Desktop Messaging. Your Inbox contains your received, sent, draft, and deleted CallPilot messages.
From the Inbox, you can open, move, copy, delete, forward, and reply to messages, and compose new
messages.

The CallPilot indicator in the Windows system tray turns red when you have a new message.

To open Desktop To create a new Moves a To open a Downloads all
Messaging, double-click the  message click New message to message, double- CallPilot messages
Mail icon in the Workspace CallPilot Message the Trash click the message
at Office window line

| CallPilot Desktop Messaging',Inbox - Lotus Yotes _1al x|
Ele Edt Yiew Creste Actions Help & D S @
e Y CalFiol Deskiop WessAgingiinbos notes
% IR CalPiofhisssags Dalete ane To Folgér Fnrwald ED Aoy By oot Dnl’wr\lnadAHMessages 5
o Who | Date | Subiect
@ Inbox
brf| <2 s
: F Gent E Unknown 12/05/2001 1225 Pt [7365) Fica receipt ;
E % o Subject shows
T Tk FF LIND# SZ0STAK 12/05/2001 02:42 PM [7609) 003 Vakge Messa sender’s phone
< Discussion Threads ) Dione Boutller  12/05/2001 0650 Fid [7241) 0:05 Vioick Message number
1 Fules * F Magon Stinett 120542001 053 Fid [7366) 003 Voice Ylessags
= Stationery
(1 Group Calendars
@ w =l /CalPilat Desktop Mess
£l Disfts
B Inbo
@ © =
| i *|Using| database on ptorddbe-01 A odeph \ *|=2| Dffice =S
To open your Star fcon Exclamation mark  Sleuth icon Read receipt shows
Inbox, click indicates a new shows that this shows that this that your message was
Folders and Views, then message message is message is opened by the recipient
CallPilot Desktop Messaging Urgent Private

To work offline
See the instructions in the online Help for configuring Desktop Messaging so that you can work offline.

To retrieve your messages before you work offline

1 Log on to Lotus Notes, open your Inbox, and on the Actions menu, click Download All
Messages.

When you want to work offline, log off and restart Lotus Notes in Island mode. You can then review your
messages and record new messages from your computer. Lotus Notes stores the messages you send
in Island mode and sends them the next time you connect to the CallPilot server. You can log on to
CallPilot from Island mode.
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Playing a message

To play a voice message
To open a voice message, double-click the message line. The CallPilot Player appears.

You can choose to play your voice messages from your computer or your telephone by clicking the
Telephone or Computer icon in the CallPilot Player. You can change this selection at any time. If you
select Telephone, the phone rings when you open a message, and the message plays when you

answer. If you select Computer, your messages play through your computer’s speakers or your
headphones.

[E CallPilot Player - (7400]) 0:08 Yoice Message

Move File Edit Commands Toolz Help | Reply to All
message to 3 W
Trash | ) Reply
Frarm: ohi Srith ——— Forward
Tt MARION STIRRETT
Position in Ce:
message Subject: |[?4DD] 0:08 Voice Message
Deliversd Naormal Sensitivit}l:IPuinc "I 247/001:27 PM
Duration of o
message 2
I J — 008 NEIRTEL
: g . MNETWORKS .
Play/replay\ Click to play all
Unregistered messages from
Stop/— ’I«!/«l JRJ J | /your computer
. & E Ml = .
Adjust volume— <®: » -\!< Click to play all
| —messages from
your telephone
Go to start Go to end -Adjust speed
of message Skip back Skip forward of message

To change your audio device

1 On the CallPilot Player by click the Telephone or Computer icon.
Or

1 In Lotus Notes, on the Actions menu, click CallPilot Configuration.
2 Click the Audio tab, and select Telephone or Computer.

To change the telephone number that CallPilot dials to play your voice messages

1 On the Audio tab make sure that Telephone is selected as your audio device, then change the
telephone number.
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To record and send a voice message

You create a voice message by opening a new CallPilot message and recording a message from your
computer or your telephone. You can send the message or save it to send later.

1
2

In the CallPilot Desktop Messaging Inbox, click the New CallPilot Message icon.

On the CallPilot Player, click the Record button to start recording. Your message can be a
maximum of 10 minutes long.

If you are recording from the computer, record your message into the microphone. Click Stop to
end the recording.

If you are recording from the telephone, answer it when it rings. At the tone, record your message.

Click Stop to end the recording, and then hang up.
4 Click To to open your personal Address Book, or type the formatted address in the To field.

For addressing information, see “Addressing messages” on page 16.

5 Add attachments and options if required. See “Adding attachments “ on page 15 and “Setting
message options“ on page 17.

6 On the toolbar, click the Send Message icon.

o —
Save —
Cc. |

Opens the Personal
Address Book. You
must use CallPilot
addresses, not

e-mail addresses.

Message options:

* Urgent or Normal
Delivery

* Public or Private

¢ Read receipt

[E callPilot Plaper
File Edit Commands Tools

Help

[_[O]x]

Click the Attach

File icon to

=] sl 4

attach a voice

ane Dog

Ecc: |

Subject: I\/mice message

Deliver}l:lNurmaI j Sensitivily:IPuinc j

I Readreceipt
™ Delivery receipt

—

Text Mezsage J

NQII}TEI. .

o 1 I e I I _'0J|

Woioe
Message

file

Click the Telephone
icon to open the

L_CallPilot Player,
and then record
your message

Click to record all
| —messages from

/@/ —— & - i B g/ your computer
\ Click to record all

~~messages from

/ Z| your telephone

/

Adjust volume Adjust speed

Stop Record/Stop

To save a newly created voice message as a file

You can record a voice message and save it as a file to use later.

1
2
3

In a new CallPilot message, record a message.
On the File menu, click Save as.

In the File name box, type a name for the file, select a folder to keep the file in, then click Save.
Save a voice file as a vbk file if your recipients are CallPilot users. Save the file as a wav file if
some of your recipients do not use CallPilot.
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You can forward a voice message and record an introduction to send with it. You can also record a
reply to the sender of a message, or to the sender and all the recipients of a message.

To forward or reply to a message ¥ CalPilot Player EEE|
1 In an open message, click the Forward N
e ’ o| B &
Reply, or Reply to all icon. 2 - E
To. lane Do
2  Follow the steps for recording a message on &=
Bec...
page 14. Subject: [P (7400) 017 Hoice message

3  Address the message the same way that you ety ot (=], Sersiy[Fube =] |- BoaieceRt
address a new message. Refer to “Addressing B —
a message” on page 16. If you are replying to | reiwesmse ) E—
a message, your reply is addressed —
automatically. " > (m Mﬂgﬂ O
e F —F— G o —F— » [BE

Messags

You can change the subject line before you send
the message. The subject can be a maximum of 80
characters.

Note: Do not use the right-click menu to forward a
Desktop Messaging message. To forward a message,

either:

. open the message and forward it from the CallPilot
window
or

« select the message in the Inbox and forward it
from the toolbar.

Before you send a message, you can attach a voice file to it. You can send either vbk or wav files to
CallPilot recipients. Voice files that you send to recipients who do not use CallPilot must be wav files.
For more information see “Sending a message to an external recipient” on page 5.

To attach a file to a message

1 In anew CallPilot message, click the Attach | ca;..,.p..,,e, ==
File icon. File Edit Commands 1 jpere=bele
- Slsle] Blkl2l
2 Browse for the file you yvapt to attgch or type o —
the name of the voice file in the File name box. &= V__me Saoms =l @] o o
The files you attach must be in wav or vbk =N —
format ubiect (P 0155 ot —
' Delivery lm \I_li Speschvbk
3  Click the Open button to attach the file and = L speschoay
return to the new CallPilot message. Tﬁg
| Fie name m — =

Voioe Files of type: | Files [*wav: vbk 25 tet) =l ]
Message

=T
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To address a message manually

You can type an address directly into the To box of a new message. Enclose the address in quotation
marks. Refer to the online Help for the correct addressing formats.

You can download the names and addresses of any CallPilot users on your Lotus Notes server to your
personal Address Book. After you download this list, you can add to it or edit it.

To download CallPilot addresses to your personal Address Book
1 For automatic download, in your Inbox, on the Actions menu, click CallPilot Configuration, and

then click the Address Book tab.

2 Select Download address book at logon, then click the OK button.

Or

1 For manual download, in your Inbox, on the Actions menu, click CallPilot Configuration, then
click the Address Book tab. Make sure the Download Address Book at logon box is not checked.

2 Inthe Workspace at Office window, double-click the Address Book icon.

w

4 On the Actions menu, click Download CallPilot Address Book.

To add names to your personal Address Book

You can create a CallPilot address manually and
add it to your personal Address Book.

1 Double-click the Address Book icon in the
Workspace at Office window.

2 Select People (CallPilot), and then click the
Add Person button.

3 Enter at least a Last Name and First Name.

4  Click the arrow beside CallPilot Address to

open the CallPilot Address Assistant. Select
the appropriate address type.

In your personal Address Book, in the left pane, click People (CallPilot).

W

Mertel Name &

Stirrett's Address Book - Peopl

B (Untitled)

T Close | 3 save

HName
First narme:

" dobn

4 Al e Id Bt Perst

w3 Folders and Views
Q, Companies
Q, Groups
Q, Groups (CalPict)

Q, Locations
a E

2, [Pesple (CalPiot
- :

Q, Cettificates =

Last narme:

" Srrith

Full user narne:

" John Srith

NORTEL CallPilot
Cifice phene:

V12345677400

CallPilet Address:

“famaserrac@testcacom

j

CallPilot Address

5 Inthe Address dialog box, enter the required details. Refer to the online Help for the correct

addressing formats.

6 Click Add Address to Personal Address Book, and then click the OK button.
7 In Person (CallPilot), click the Save button, then click the Close button.

To address a message from the address book

1 In anew CallPilot message, click To and select either the CallPilot address list on your Lotus Notes

server, or, in your personal Address Book, select People or Groups (CallPilot).

2 From the Name list, select the name of the recipient.
Click To ->. To select one or more addresses, click To -> after each one.

3 Click the OK button to return to the new CallPilot message.
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In a new CallPilot message, you can set priority, sensitivity, and acknowledgment options.

To set Delivery priority for a message

Select Urgent, or leave the setting as Normal. The [T R [C[Ol<]
Economy option is the same as the Normal setting. Jlal ol=le
To set Sensitivity for a message [T e Doe
Select Private, or leave the setting as Public. EE:||
Subject Voice message
Be aware that messages you send marked Private T R A
can be forwarded by the recipient. Also, recipients = T
in non-CallPilot systems may not be informed of v ) — 1L

Private settings. In your message, tell the recipient
that the message is Private.

0|l ) o)
o G — = » —— " [BEF

Messags

To request a Read receipt

Select Read receipt to request acknowledgment
that the recipient received the message. Delivery
receipt is not supported.

Configuring Lotus Notes to automatically check for messages

To make sure that your Lotus Notes messages are current, you can configure Lotus Notes to
automatically check for messages.

To configure Lotus Notes to automatically check for messages
1  On the File menu click Preferences and then click User Preferences.
2 Click Mail and News Settings.

3 At the Receiving option select Check for new mail every __ minutes, and enter a number for how
often you want Lotus Notes to check for new messages.

For more information about configuring Lotus Notes, refer to your Lotus Notes documentation.

When you delete a message in Lotus Notes, the message moves to the Trash folder. To permanently
delete these messages, select Actions and click Empty Trash.

To delete a message while it is open, click the Empty Trash icon on the toolbar of the open message to
delete the message. The message is permanently deleted, and does not move to the Trash folder.
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GallPilot Desktop Messaging
for Novell GroupWise

When you open Novell GroupWise, your CallPilot messages appear in the CallPilot Desktop Messaging
folder. You can open, move, copy, delete, forward, and reply to messages, and compose new
messages.

The CallPilot indicator in the Windows system tray turns red when you have a new message.

&% GroupWise - CallPilot Desktop Messaging [_ O] x]
File Edit Wiew Actions Took MWindow Help

JDlspIay <CallPilot Desktop Messaq 7| | | @ 2] 2| G, %H%H%H >i3|

To create a new
- .
s f=l message, click

@ wiiter] | From | Subject [ Date :
The CallPilot | 9 3 [CalPit D eskiop Messaging] [ Unknown i T ST Vacs tenags Givi iz | the New C_a“P"Ot
. G P Maibo .@ John Smith [7747) Fan1D: 1026; 2 p Fax mvoronaiss | Message icon
Desktop Messaging 5 Sent ltems John Srith (7400) 0106 Yoice Messa 03/02/00 0303

[ Calendar
Documents
Task List
‘41 Work In Progress
] Cabinet

John Smith [7366) Fax 1D: 1037; Far acknow 03/02/00 06:37
Pastmaster [System] Fax ID: 138; Dehvaw teport [0 0 06:37 SUbJeCt ShOWS the

John Smith (7400) 0:05 Voice Message /02700 s
“T~senders phone
number.
| o

folder contains your
CallPilot messages

Ld’
i}

You can move a
message to a new
folder that you create
inside your CallPilot

folder. q .
/Al [ / Selected: 0 [Thyal & E

Date and time
received

Red icon means New messages To open a message, A Read receipt
that this message appear in bold double-click the shows that the
is urgent message line recipient opened

your message.

To work offline

To work offline, you need a computer that has Desktop Messaging installed and configured in the same
way as your office computer.

1 Log on to Novell GroupWise.

2 On the Tools menu click CallPilot Desktop Messaging.

3 Click Download all CallPilot Messages. You can now work offline, review your messages and
record new messages from your computer. CallPilot stores your new messages and sends them
the next time you log on to the CallPilot server.
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Playing a message

To play a voice message
To open a voice message, double-click the message line. The CallPilot Player appears.

You can choose to play your voice messages from your telephone or your computer by clicking the
Telephone or Computer icon in the CallPilot Player. You can change this selection at any time. If you
select Telephone, the phone rings when you open a message, and the message plays when you
answer. If you select Computer, your messages play through your computer’s speakers or your
headphones.

[E CallPilot Player - (7400) 0:06 Yoice Message _ (O] x|
Delete File Edit Commands Tool: Help Open next
message message
3| ol
Forward From: Smith Open
Tar MARION STIRRETT [——previous
message
Reply [
Subject: |[?4DD] 0:06 Yoice Message
Delivery: [Nomal  ~| Sensitivity: [Public  ~] 03/02/00 03:09 PM
Position in L0003

message /;JW NQRTE | Status
Durationof :
message | . ,U—’J—\’J » | J Playing. Click to play
| _—messages from
Playiroplay— | —_ \ N —f— B Ql[Z—| vourcomputer
Stop/ Click to play
“INmessages from

e/ your telephone

Adjust volum

-Adjust speed

Go to start  Skip back  Skip forward Go to end
of message of message

To change your audio device

1 On the CallPilot Player, click the Telephone or Computer icon.
Or

1 Inyour Inbox, on the Tools menu, click CallPilot Desktop Messaging.
2 Click CallPilot Desktop Messaging Options.
3 Click the Audio tab, and select Telephone or Computer.

To change the telephone number that CallPilot dials to play your voice messages

1 On the Audio tab make sure that Telephone is selected as your audio, and then change the
telephone number.
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You can compose a voice message in the CallPilot Player. Your message can be a new message, a
reply to a received message, or an introduction to a forwarded message. Before you send a message,
you can add voice attachments and options.

To record and send a voice message

You create a voice message by opening a new CallPilot message and recording a message from your
computer or your telephone. You can send the message or save it to send later.

1 On the Novell GroupWise toolbar, click the New CallPilot Message icon.

2 On the CallPilot Player, click the Record button to start recording. Your message can be a
maximum of 10 minutes long.

3 If you are recording from the computer, record your message into the microphone. Click Stop to
end the recording.

If you are recording from the telephone, answer when it rings. At the tone, record your message.
Click Stop to end the recording, and then hang up.

4 Click To to open the Address Book, or type the formatted address in the To box. For how to
address a message, see page 22. To add attachments and options see pages 21 and 23.

5 On the toolbar, click the Send Message icon.

[¥ callPilot Player [_[O[=]
File Edit Commands Toolz Help Click the Attach

Send message ——@Jﬂlﬁl ml;_w [g;JI File icon to

attach a voice

Save message To. | flansDee filed
Cc... |

Open the Bee |

Address Book Subject: [voice Message Click the Telephone

M i _—TDeliveny: INUrmaI j Sensitivity:IPublic j F E:?je;zc;:féipt \g:n;ﬁo?%elgytgre
essage options: ,

—

« Urgent or Normal and then record your
Delivery J . NQEEE}D“S message

« Public or Private :

« Read receipt | ] o ] _.\J |

- § Click to record all
G- »\— {3 |E—1—messages from

your computer

Click to record all
\ messages from
Stop Adjust volume  '‘Record MAdjust speed  your telephone

To save a newly created voice message as a file
You can record a voice message and save it as a file to use later.
1 In anew CallPilot message, record a message, and on the File menu, click Save as.

2 In the File name box, type a name for the file, select a folder to keep the file in, then click Save.
Save a voice file as a vbk files if your recipients are CallPilot users. Save a voice file as a wav file
for non-CallPilot users.
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You can forward a voice message and record an introduction to send with it. You can also record a
reply to the sender of a message, or to the sender and all the recipients of a message.

To forward or reply to a message

3 In an open message, click the Forward, ‘Eaﬂvlﬂawr o =

Reply, or Reply to all icon. 0 8 S ST L

ply ply . (el sl

4 Follow the steps for recording a message on —

page 20. e,

Bcc..
5 Address a forwarded message the same way St IOV e
™ Delivery receipt

as a new message. For information on Deivey: [T ] SemstepFore ] I Feadosit
addressing a message see page 22. If you are = o

replying to a message, your reply is addressed P S [ws. NIORTEL

i Message ' ' '
automatically. e EE s
You can change the subject line before you send ¢ —— @ » —— » o=
the message. The subject can be a maximum of 80
characters. z

Note: Do not use the right-click menu to forward a
Desktop Messaging message. To forward a message,

either:

. open the message and forward it from the CallPilot
window
or

« select the message in the Inbox and forward it
from the toolbar.

Before you send a message, you can attach a voice file to it. You can send either vbk or wav files to
CallPilot recipients. Voice files that you send to recipients who do not use CallPilot must be wav files.
For more information see “Sending a message to an external recipient” on page 5.

To attach a file to a message

1 In anew CallPilot message, click the Attach A NEH i R I [=]
F|Ie iCOI"I File Edit Commands T palmelaley

2 Browse for the voice file you want to attach, or o =
type the name of the file in the File name box. ER i El=E —
The files you attach must be in wav or vbk Boo..| [ Do
format. | e

Deliveny [t (2] License.tut
Z] Readmeus st

3 Click the Open button to attach the file and
return to the new CallPilot message.

Voice
Message

[ Flegemz ] [ oeen ||
Files of type: [Files (~wa~ bk~ "] =l Cancel HIE

CallPilot Desktop Messaging for Novell GroupWise 21




To add CallPilot addresses to your personal Address Book

You can add CallPilot addresses to the list of e-mail addresses in your personal Address Book. You
may want to distinguish between CallPilot and e-mail addresses by adding CallPilot after the recipient’s
name. You can also add distribution list names to your personal Address Book.

You can add a CallPilot address to your personal - Address Book =] B
Address Book by copying it. e [ WA ke ke
. . . NovellGroupise Address Book | Frequent Contacts | address Book | CalPiot Address Book |
1 In the Ca||PI|0t AddreSS BOOK, r|ght'CI|Ck the Search List: ;_i\]} Mame Completion Position; 1,9
name you want to add. |, s Botwrocn Address Books 161 I |
2 Click Copy to. [Thane — 77 bk [caress
& 00000DcNotDel
e . S —— | I—
3 In Copy Names Between Address Books, b Llser _Cod |
sBeIeI((:t th% r;re:me (la_f K(:Er pglr(sct))n?tl Address Treesor. Do s
ook, and then click the utton.
a | ¥

Ogse | Diol | Mal | Add. | Remove | Information | = Addvess Lists> |

To create an address manually and add it to T o=y

File Edit “iew Addiesz Help
your personal Address Book
Movell Groupwise Address Bookl Frequent Contacts  Address Book |Cal\F‘iIot Lddress Bookl

1 Onthe Tools menu, select Address Book. SsachList - Mame Completion Posion: Mot searched o5
2 Select your personal Address BOOk and then I | Mame | Office Phona...l Department | Fai Mumber | E-Mail Address ‘
€ ) o = - - ‘
click the Add button. fMaMe, SfNewEoy  EE|
H Mail User elecl 2 ertry B
3 From the New Entry list, select Person and Michael Kleza Pt "

click the OK button. & pesace _ Cerea |

4 Click the CallPilot — General tab. Select the
appropriate address type. Enter the required
address details. Refer to the online Help for the
correct addressing formats. . a0 |

5 C”Ck the OK button Clase Dial Mail Add. | Remave |nfarmation | Address List >> I

To address a message from your address book

1 In anew CallPilot message, click To.

Select CallPilot Address Book or your personal Address Book.

Select the name of the recipient.

Click Add ->. To select one or more addresses, click Add -> after each one.
Click the OK button to return to the new CallPilot message.

a b WODN

To address a message manually

You can type an address directly into the To field of a new message. Refer to the online Help for the
correct addressing formats.
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In a new CallPilot message, you can set priority, sensitivity, and acknowledgment options.

To set Delivery priority for a message

Select Urgent, or leave the setting as Normal. The IEIEN B[l Ed
. . . File Edit Commands Tools Hel
Economy option is the same as the Normal setting. <

pin L= Y el B )
To set Sensitivity for a message e
Select Private, or leave the setting as Public. ;—i

Sullect: Voice Message

Be aware that messages you send marked Private
can be forwarded by the recipient. Also, recipients

Del

. 4
ey [ligern =], Sensitviy [Frvae =] [2 et
el

—
in non-CallPilot systems may not be informed of VO T [ NERmEL_
Private settings. In your message, tell the recipient Message : : ETVORK
that the message is Private. JNL 0 L T T

. — B I [
To request a Read receipt : =4 = o=
Select Read receipt to request acknowledgment 4

that the recipient received the message. Delivery
receipt is not supported.

If you use Novell GroupWise and you delete a CallPilot message, the message is deleted immediately.
It is not moved to a deleted items folder.
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CaliPilot Desktop Messaging
for Internet mail applications

You can use these Internet mail applications with CallPilot Desktop Messaging:

*  Netscape Messenger

e Microsoft Outlook Express
e Microsoft Outlook 98

e Eudora Pro

Ask your administrator whether the version of the application you use is supported.

When you open your Internet mail application, you see your CallPilot messages and your e-mail
messages. You can open, move, copy, delete, forward, reply to and compose CallPilot messages.

# Inbox - Netscape Folder CEL=
To open a message,  Ee Edt Vew Go Message Communicaor Help
double-click the T T A
message line :N [E wMjgb Fiepl _ HIEDL)JAII Foward  File Next an‘ SDe;ete m[;). : — . Deleted messages

e =1 5.bpc ender S o
551 tor_com are deleted
=) (7413 Fax ID: 1028: Text Message + Diane Hoton  wed 309 PH immediate|y or
. & Laca = (7413) Fa ID: 1026; 2 p Fax Messags o Diane Horton  Wed 306 PM I~ -
SUbJECt shows EF news = [7400) 0:03 P [7366) 0:03 Voice Message » JohnSmith  Wed 1:10PM Iater, dependlng on
sender and £ s et e your configuration
message details. =T (System] Fax 1D: 1023; Delivery report (success)  » Postmaster  wed 12:43 PM
—] i = (7400) 017 Voice Message o JohnSmith  Wed 10:21 AM
:
EAEE] [Totalmessages 8 Uniead messages: 0

Using the CallPilot Player

Use the CallPilot Player to play and record voice messages. To open the CallPilot Player, click the Start
button, click Programs, click Nortel Networks CallPilot Desktop Messaging, then click CallPilot Player.
Refer to the online Help for the CallPilot Player for configuration information.

& (7400) 0:08 VYoice Message - Netscape Message _ O] x|
File Edit Yiew Go Message Communicator Help

GetMzg  MewMsg  Heply Fremlindll Farward, File Mext Print [elete Stop
Suhject: (7400) 0:08 Voice Message ,@'
Date: 17 Feb 2000 13 [y ey ey T [E=]

From: "John Srnith" <1<
To: "MARION STIE

File Commands Tools Help
00:05
. . 0008 :
Positionin______ 1~ - L J mﬁ%s Click to play all
message ‘,480102 bk | -messages from

T .
rrotin 21| I o [ ] @] Peine your telephone
Duration of _—1~ R g .
message £2 ;L/ <E)% \{ » B =] Clicktoplayall

/ \ I~~messages from
Play/replay /?r@/ __— Document: Doyl | \ Nk 4B DR ED A | 4| your computer
I \ f

Stop Adjust Go to start  Skip Skip Go to end Record  Adjust
volume  of message back forward of message speed

Ly
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To play a voice message
1 Double-click the message to open it.
2 Click the Voice icon to open the CallPilot Player.

3 On the CallPilot Player, click the Telephone or Computer icon to select the audio device for
playing voice messages. You can change this selection at any time.

If you select Telephone, the phone rings when you open a message, and the message plays when
you answer.

If you select Computer, your message plays through your computer speakers or your headphones.

When you address a message, use only CallPilot addresses. Depending on the Internet Mail client you
use, you may be able to set options such as urgent or private.
To compose and send a message

1 In anew CallPilot message, record your message. Your message can be a maximum of 10
minutes long.

2 On the File menu, click Save As and type a name for the file. Save it as a .vbk file if you are
sending to CallPilot subscribers, or as a .wav file for non-CallPilot users. Click the Save button.

3 Click the To button. Select a CallPilot address from your address book, or type a CallPilot address
in the To box.

4 Click the Send button.

To forward or reply to a message

1 Click the Forward, Reply, or Reply All icons to open a new message window. Do not right-click to
forward a message.

2 Record your message.

3  Click the To button. Select a CallPilot address from your address book, or type a CallPilot address
in the To box. If you are replying to a message, your reply is addressed automatically.

4 Click the Send button.

To attach a file to a message

1 Click the Attach or Insert File icon in the new message window.

2 Navigate to the file that you want to attach, select it, then click Open or Attach.

Deleting a message

By default, Internet Mail clients (Netscape Messenger, Microsoft Outlook Express and Outlook 98, and
Eudora Pro) move deleted CallPilot messages to a Deleted Items or Trash folder where you can
recover the messages or permanently delete them.

Messages stored in this folder remain in your CallPilot mailbox on the CallPilot server until they are
permanently deleted. To permanently delete the messages, empty this folder. For more information,
refer your email client’s online Help.
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